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UITE Getting Started

Chapter 1
Getting Started

The Getting Started User Manual explains basic information for using the I-Suite application. Topics in
this section include:

I-Suite System Requirements (See Page 4)
I-Suite Installation and Initial Setup (See Page 5)
Logging into I-Suite (See Page 29)

Common Features (See Page 35)

Accessing Help (See Page 44)

General Instructions (See Page 46)

I-Suite Module Descriptions (See Page 48)
Working with Grids (See Page 52)

Options (See Page 55)

Uninstalling I-Suite (See Page 74)

I-Suite System Requirements

To install and run the I-Suite application, your personal computer must have the following minimum
system requirements:

e Microsoft Windows XP
OR

e Windows 7
e Administrator Privileges

[-Suite Version 13.01.00 Getting Started 4
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Chapter 1

I-Suite Installation and Initial Setup

This section explains how to download and install the I-Suite application.

To download and install software on an agency personal computer, you must follow that agency's
regulations and requirements. You may also need to have Administrator access privileges granted before
starting this process. For more information, contact your agency's System Administrator. If the computer
will be the server or if you are running in stand-alone mode, make sure you install the Server application.

Downloading I-Suite

Follow the steps in this section to download the I-Suite application from the I-Suite Website:
1. Open your Web browser and access the Internet.

In the Address box, type isuite.nwcg.gov to open the |-Suite Website.

Click the Download button that displays at the top of the Web page.

> LD

When the Download page displays, scroll down the page until you see the
version you want to download.

|The most recent version of the program displays at the top of the page.

5. Click the Server link to download the server version of the program. Click the
Client link to download the client version of the program.

6. When the Save window displays, use the options on the window to identify where
you want to download the program. Then click OK or Save (depending on your
browser) to download the file to your computer.

Installing I-Suite

Follow the steps in this section to install either the |-Suite Server application or the Client application.
The main difference between the Server and Client applications is that the database and database
servers are not installed with the Client system.

IMake sure you exit all software applications before starting the installation process.

[-Suite Version 13.01.00 Getting Started 5



Chapter 2:1-Suite Installation

1. Access the folder where you downloaded the I-Suite program. (See Downloading
I-Suite on Page 5)

2. Double click the I1-Suite program file (either Client or Server) to begin the
installation process.

3. When the first InstallShield Wizard window displays, click the Next button.

4. Follow the instructions that display on the InstallShield Wizard windows to install
the |-Suite system.

The InstallShield creates and installs the I-Suite application to the correct folders. DO NOT select a
different Destination Folder.

5. When the installation process is complete, click the Finish button to restart your
computer. You can then delete the downloaded installation file.

If you were installing the I-Suite Client, refer to the First Time Logging into I-Suite - Client (See Page 19)
instructions. If you were installing the I-Suite Server, refer to the First Time Logging into |-Suite -Server
(See Page 16) Instructions.

Enabling Server Connectivity for Windows XP/Windows 7

Follow the steps in this section to enable SQL server connectivity for Windows XP Service Pack 2:

To complete these procedures, you must be logged into Windows as an administrator. If you are running
other instances of SQL Server, you will need to create an exception for the instance. If you decide at a
later time that you do not want the instance included in the Exception's list, uncheck the checkbox next
to the instance.

1. Click the Windows Start menu. Then click the Run option to open the Run
window.

i Type the name of a program, folder, document, ar
- Internet resource, and Windows will open it for you,

Qpen: | Iéirewaii..cp". o

[ Ok l[ Cancel ][ Browse...

2. Inthe Open box, enter Firewall.cpl, and then click the OK button. The Windows Firewall window
displays.

[-Suite Version 13.01.00 Getting Started 6



Chapter 2:1-Suite Installation

= Windows Firewall

Gerneral | Erceptions | Advanced

Windows Firewall is turned off. 'our computer iz at rigk of attacks and intruzions
from outzide sources such as the Intermet. We recommend that you click, the
eneral tab and select On.

Frograms and Services:

M ame

AL

AL

[ File and Printer Sharing
Rermote Assistance

O Remate Desktop

O UPAP Framewark,

| 4ddProgam.. | [ addPor. ||  Edt. ||  Deke

Dizplay a notification when Windows Firewall blocks a program

What are the rizks of allowing exceptiong?

[ OF. l [ Cancel

3. Click the Exceptions tab to select it.

In Windows 7 machines, instead of click on the Exceptions TAB, the user will click on the words "Allow a
program or feature through Windows Firewall" in the upper left corner of the Windows Firewall screen.

[-Suite Version 13.01.00 Getting Started 7
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1. Click the Add Program button to open the Add Program window.

Add a Program

Programs:

) QuickTime Player
@ GuickTirme Updater

@) FealPlaper
@ RealFlayer Setup

é Snaglt 8
8l Solitaire
&] Spider Solitaire

E alzerr

Jmal

Change scope...

To allow communications with a program by adding it to the Exceptions list,
zelect the program, or click Browse to search for one that iz not listed.

@ [uickBooksz Simple Start Special Edition

f! Fegister Adobe Phatoshop 5.5

51 Spybat - Search & Destroy

Path: | C:AProgram Files\Microzoft SOL ServeryhdS50

&

W

Ok ][ Cancel ]

5. Click the Browse button to open a Browse window. Use this window to locate the
instance of SQL Server that you want to add to the Exceptions list. It should be
located in C:\Program Files\Microsoft SQL Server\MSSQLS$ISUITE2\Bin.

6. Click the name of the instance (sqlserver) and then click the Open button.

7. When the Add a Program window redisplays, make sure the name of the
instance is highlighted, then click the OK button.

8. When the Windows Firewall window redisplays, make sure the instance displays

under Programs and Services.

9. Click the checkbox next to the name of the instance to check it. Then click the OK

button.

Setting ISuite Exceptions in Windows 7 Firewall:

Follow the steps in this section to set ISuite exceptions in Windows 7 Firewall.

1. In the Control Panel, select System and Security then Windows Firewall.

I-Suite Version 13.01.00

Getting Started 8



Chapter 2:1-Suite Installation

@-’@v!% ¢ Control Panel » System and Secunty »

Control Panel Home

Action Center
Review your compi

* System and Security

Metwork and Intermet

Troubleshoot g

Windows Firewall

Check firewall status Allow §

Hardware and Sound
Programs

User Accounts and Family S_'_',-’STEH"I
Safety View amount of RAM and procs

B Allow remote access See

e & ¢

Appearance and
Personalzation —

t Windows Update

Clock Language, and Region Turn automatic updating on or

Ease of Access

Power Ontinns

b

2. Select Allow a program or feature through Windows Firewall.

| s » Control Panel » System and Security »

Control Panel Home

*W Action Center
et yter's sbatys e 1ssiues g Chan Us
5 Systen s - 1 Review your computer's status and resobve issue ¥ Change U

Troubleshoot common computer problems Restore your ¢

ount Control e

uter to an earlier time
Metwork and Internet

Hardware and Sound Windows Firewall :
Check firewall status Allow a program through Windows Firewall

Programs
User Accounts and Farnily :fh System )
Safety View amount of RAM and processor speed Check the Windows Expenence Index

Riiptasaics ha 9 Allow remote access | See the name of this computer | Mg Device Manager

Personalization

| Clock {anguage and Region

[+ ] Windows Update

i L Lk ik . i i

3. Click Change Settings then click Allow another program.
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To add, change ef remove sllowed programs and poms, chick Change settings,

Allow programs to communicate through Windows Firewall /

‘What are the risks of slowing 2 program to comemnicate? i

Allgwed programs and features:

Hame Home Wark [Prevaiel  Public

[l BranchCache - Content Retrieval {Uses HTTF) O |

[l BranchCache - Hosted Cache Chent (Uses HTTPS) O O e
[l BranchCache - Hosted Cache Server {Uses HTTES) 0O m

[l BranchCache - Peer Disceveny (Uses W50 [} O

Ol Cannect to a Mebwark Progector [m] O

¥ Core Networking ) 1=

[ Destributed Transsction Coondinstor O .

BF Deephiox O 7]
Edmphm.m =) O

I File arsl Prsbes ‘Elhmlrlg = 0
OHomeGroup a i
1563 Service O O -

Fﬂﬂlhm

_— " allow another prn-grnmr i

4. Browse to C:\Program Files|ISuite\.

[The location will be C:\Program Files(x86)\ISuite on Windows 64-bit systems.

@ & Contml Parsl ¢ Tyoiwm e Secumy 8 Windowi fuwasi]l & Alowsd Frogom = iy

#llow programs to commnicate tinoagh Windows Firesall
T2 ad changa =i ramovs aliowsd pregiom nd perr. cak Chings ssting

e provgil) kel w. Bacgram -
[r [Py — p— =
Sl GmE——— -
ml o | 00
Dl 8smnchCad
Dlemeea 1 szl 7 e et
Bicore Mol | 3 Saeg Do Gt s
Closrinbsss] i o
[ [T 8 23 Librnm :_ ¢
B dsaphaae ¢ Deoureri: -
Pl ard B & Misic k WP
Dlitaatiael e i 4 pe——
Tk ey B et L Buma
brva
a4 S My g Sl
g Mg Offie
Mot Secyriny Chear
* (¥ Campute ¥
e Microeah Siemlighn
& o5 it
— icroazh GL Sarew
mun MIEE DOMTHG _ 3 U

Fig sgme » |dpghcstiam fog el -

Opm | LCoace

5. Click Open. On the Add a Program window click Add.
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il Securly ® Wirsdorws Fucesddl b Allwesd Frogrami

Al programs 1o oommurscate through Wirdows Firewall
Toudd change. o remoess sliowsd progreme and gosr, dick Change settinge.

i i the ks of @ i Ly TTFTILE it
Aloaed presg Ll |
Mame Fefect thee oragren pa s b add, or dick Brossse: i find sne i s not || Pubbc =
ClBranchady e, ard S cee oo, o
Oennchad| o o
z B b -
[ 'IEllll'.H:m:" : r Py ]
Difenchiod] | B pove Tode 2.0 H
Dennmctig) | oy vmin Brgre Corrd Cants L o
BCere betwll | 3 Coreerie o Farasoh Publve & QuadiFras i =]
[m[=*1 L, Crexie & Sygien Regas Do u]
Bz phas ARt boran ¢ Bk =]
Barogbowafl | 1 Googe e o
FFile andi by | i Gaage Dre o
W #:“ﬂl#:u:ﬁ -
L [ Irimrress Euplorer [R50 rt
Clescat il | g -8
- | "
Falfe 2 Frogrm T (o Swte Rt .o | Eooweae.. !
Mo poe: e iy 1 unblocin B or e Bl

Tiow can choam rhich refso—k locstion bypes o sdd thin o

Teptioh ke.ohes: et | s
| )

6. Repeat the above steps for sqlservr (C:\Program Files\Microsoft
SQL Server\mSSQL.1\MSSQL\Binn)\sqlservr)

—
l@' LA Computer 8 05{C] & Progiem Flles (6] & Microse#t SOL Server b MISSQLY » MSSQL & Bon 8
Cuganize = Imclisde in library Shang with + Bum et Folder
s Favites Hame - Diate modified Type Size
B Desitop Rescrurced
& Downloads | batchparserd0.dl Apphcatan edens 22 KB
s Draples %] DBGHELP.DLL 1172 Application edens. 1513 KB
4. Recent Places 5| ODSOLEM.JN 1211 Application eden: 55KB
& Google Drive % ependsil.dl ! Applicetian eten 71 KB
2| perd-ISUTTEZsqictr KB
4 3 Libranes %) sqlaceess.ll 340 KB
+ Documents %] SQLBOOT.dE 12 46 KD
&' Music sghkctrh 1L 11 %R
Bl Pictures 3| sagiety 1172472008 2 4948
B visees "7 sofmaint 124 & KB
| sqios.dil 12 LA
o} Homegroup %, spireictB0.d1l 10 X B KB
2 Sqlfwseuscel cadur 1045 18 KB
a1 Computer b m\:ﬂﬂlya 10714/ KB
i oSy # 1 sqpseret L2AZ0L0 T K
wm AIMEE DCRATH (E2) | s, dil L2 KB
Ll isseshare (V190 168.1. 71 vserverfoldears) () | vighaip-up. il KB
a, il L1/ 2475008 Lkl 4 KE
T " :

7. Repeat the above steps for sqlbrowser (C:\Program Files\Microsoft
SQL Server\90\Shared\sqlbrowser)

[-Suite Version 13.01.00 Getting Started 11
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¥~ Progrem Files [86] & Mcrosoft S04 Server b 30 b Shared -
Orgamize = ™ Open Bum e Foider
r Eavontes < =t
B Desitop ErrarDismeps
B Downloads Resources
¢ Dropbsox custsatdll
. Recert Places ¢ dbgheip.di
'5 Google Drive et
& isscctchangedll
g Libraries 1.- rndf_redf_clirfiles
| Docurments & Mstresoft NetErderpriseSeroers. Excephan
w Muigic Mecrosoft SqlSac Publc.dll
= Pacturnes £ o, maesxpress.dil
E Wadeos rmazmmlig|, o8
gl SAL
oy Homegroug 8 zqladhlp
a, SqlBoot.ci
B Cornputer 5 pqlbrowser
& o5y ® | Sqllwmiper
i ScfZRendie] Mcad7adiaaIC w solftacct s

Enabling Programs for Client Version

Follow the steps in this section to use Windows Firewall to enable programs for the client version by
adding them to the Exceptions list.

Adding a program to the Exception's list, has the following advantages:
¢ You do not have to know a specific port number.

e The port in the Exception's list that the program uses will only open when the
program is waiting to receive a connection.

If you later decide that you do not want the program included in the Exceptions list, uncheck the checkbox
next to the program.

1. Click the Windows Start menu. Then click the Run option to open the Run
window.

2. Inthe Open box, enter Firewall.cpl, and then click the OK button. The Windows
Firewall window displays.

3. Click the Exceptions tab to select it.

[-Suite Version 13.01.00 Getting Started 12



Chapter 2:1-Suite Installation
4. Click the Add Program button to open the Add Program window.

Add a Program @

To allow communications with a program by adding it to the Exceptions list,
gelect the program, or click Browse to search for one that iz not listed.

Programs:

.5 FreeCel A
< GIMP 2

W Heart:

B8 |rtel(R] PROSet for Wired Conmections

£ Intemnet Backgammon

) Internet Checkers

48 Internet Explarer

P Intemet Hearts

(’ [nternet Revers

-ﬂ |nternet Spades

Jid 15 uite 3
Path: | C:AProgram FilegsS uiteh Suite. exe

o) (ooes ]

5. Click the name of the program (Isuite.exe) and then click the Open button.

6. When the Add a Program window redisplays, make sure the name of the
program is highlighted, then click the OK button.

7. When the Windows Firewall window redisplays, make sure the program displays
under Programs and Services.

8. Click the checkbox next to the name of the program to check it. Then click the OK
button.

Create an Exception for SQL Server 2005 in Windows Firewall

In order for the SQL 2005 to communicate with the client machines, you must create an exception to the
Windows Firewall.

These instructions apply to Microsoft SQL Server 2005 Developer Edition and Microsoft Server 2005
Express Edition.

1. Click the Windows Start menu. Then click the Run option to open the Run
window.

[-Suite Version 13.01.00 Getting Started 13



Chapter 2:1-Suite Installation
2. In the Open box, enter Firewall.cpl, and then click the OK button. The Windows

Firewall window displays.

In Windows 7 machines, instead of clicking on the Exceptions TAB, the user will click on the words "Allow
a program or feature through Windows Firewall" in the upper left corner of the Windows Firewall screen.

3. Click the Exceptions tab to select it.

4. Click the Add Program button to open the Add Program window.

Add a Program @

T o allove communications with a program by adding it to the Excephions list,
zelect the program, ar click Browse to search for one that iz not lizted.

Programs:

2 FreeCel -
< GIMP 2

W Hearts

B8l [ntel[R] PROSet for Wired Connections

£ Intemet Backganmaon

) Intemet Checkers

48 Internat Explarer

P Intemnet Hearts

t,{’ Internet Rewvers

ﬂ Internet Spades

Jid 15 uite 3
Path: | C:4%Program Filesh S uitehl S uite. exe

o) (oo ]

5. Click the Browse button next to the Path field.

6. Navigate to the C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\BiNN\sqlserver.exe folder.

In Windows 7 64 Bit Machines, the folder will be in C:\Program Files(x86)\Microsoft
SQL Server\MSSQL.1\MSSQL\BiNN.

7. Click the sqlservr.exe program and the Open button.

The folder in which the sqlservr.exe program is located may be different from the path listed in step 6.
MSSQL.1 is a placeholder for the instance ID that you obtained in step 6. If you cannot find this program
located in that directory, you may need to perform a search for the sqlservr.exe file.

8. Click the OK button on the Add Program window.

[-Suite Version 13.01.00 Getting Started 14



Chapter 2:1-Suite Installation
9. Repeat steps 4 - 8 for each instance of SQL Server 2005 that needs an exception.

Create an Exception for SQL Server Browser Service
To create an exception for the SQL Server Browser service in Windows Firewall, follow these steps:

1. Click the Windows Start menu. Then click the Run option to open the Run
window.

2. Inthe Open box, enter Firewall.cpl, and then click the OK button. The Windows
Firewall window displays.

3. Click the Exceptions tab to select it.

4. Click the Add Program button to open the Add Program window.

Add a Program @

T o allove communications with a program by adding it to the Excephions list,
zelect the program, ar click Browse to search for one that iz not lizted.

Programs:

2 FreeCel -
< GIMP 2

W Hearts

B8l [ntel[R] PROSet for Wired Connections

£ Intemet Backganmaon

) Intemet Checkers

48 Internat Explarer

P Intemnet Hearts

t,{’ Internet Rewvers

ﬂ Internet Spades

Jid 15 uite 3
Path: | C:4%Program Filesh S uitehl S uite. exe

o) (oo ]

5. Click the Browse button next to the Path field.

6. Navigate to the C:\Program Files\Microsoft SQL Server\90\Shared folder.

In Windows 7 64 Bit Machines, the folder will be C:\Program Files(x86)\Microsoft SQL Server\90\Shared. |

7. Click the sqglbrowser.exe program and the Open button.

[-Suite Version 13.01.00 Getting Started 15



Chapter 2:1-Suite Installation

8. Click the OK button on the Add Program window.

The folder in which the sqlbrowser.exe program is located may be different from the path listed in step 6,
depending on where SQL Server 2005 is installed. If you cannot find this program located in that
directory, you may need to perform a search for the sqglbrowser.exe file.

First Time Logging into I-Suite -Server
Follow the steps in this section if you are logging into the I-Suite server for the first time:

1. Launch the I-Suite application. A Security Message displays indicating that
"Unauthorized access to this United States Government Computer System and
software is prohibited by Title 18, United States Code 1030."

=W arning™**Warnning*™*Warning*™**Warning**

IInautharized accezs to thiz United States Government Computer Spztem and
zoftware iz prohibited by Title 18, United States Code 1030, This statute states
that: “Whoewver knowingly, or intentionally accezses a computer without
authorization or exceeds authonized access, and by means of such conduct,
obtaing, alters, damages, destrovz, or disclozes information ar prevents
authorized uze of data or a computer owned by or operated for the Government
af the United States shall be punizhed by a fine under thiz title or imprizonment
for not more then 10 years, or both. All activities on this spstem and netwark, may
be monitored, intercepted, recarded, read, copied, ar captured in any manner
and dizclozed in any manner, by authonized personnel. THERE 15 MO RIGHT
OF PRIVACY [N THIS SYSTEM. System perzonnel may give to law enforcement
officialz any patential evidence of crimes found on thiz USDA computer system.
JSE OF THIS SYSTEM BY AMY USER, AUTHORIZED OR UMNALUTHORIZED,
COMSTITUTES COMSEMNT TO THIS MOMITORIMG, INTERCEFTIOMN,
RECORDIMG, READIMG, COPYIMG, OR CAPTURING AMD DISCLOSURE.
REPORT UMAUTHORIZED USE TO AM INFORMATION SYSTERMS
SECURITY OFFICER.

Prezs Yes to continue, ar Ma to exit

e |

[-Suite Version 13.01.00 Getting Started 16



Chapter 2:1-Suite Installation

2. If you want to continue, click the Yes button. A Login window displays:

I-Suite Login
Server Login Mode
Version: 10.00.00

Initial Server
Setup

Type Server and D atabase or select from ists.

Senver: j
Database: Ll Advanced

<< Hide |

Cancel |

3. Leave the User Name and Password boxes blank.

4. Click the Initial Server Setup button. A Rules of Behavior window displays for a
Privileged User Account.

[-Suite Version 13.01.00 Getting Started 17
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Rules of Behavior

“rou must accept the Rules of Behavior prior 1o accessing 1-Suite.

|

—

= Eesponsibilities for Users with
Privileged Access to Forest Service Systems

SDA Statement of Information Securiry m

| understand that, in addition to this document, | must understand and sign the Statement of
Employves Securty Responsibilties or the Statemert of Information Security Responsibilities for
Associate sers of Forest Service Systems

. underatand that | have been granted enhanced privileges in ander to perform
speciic funclions on information sy3iems that are part of a F& G55, and that these
privileges are to be used only to perform my asaigned job reaponsibilies

. will not use my privilegss to grant myself or any other person unauthonzed
privileges, or to modify any aces3s accounts, prvilegss, system configurations, o
data in an unautharized manner

* | understand frat | have a spacial duty to safeguard FE information resources, and will
implement and operate enterprise maasures to protect hose resourcas, as instucied
by technical information bullstins (M), standard operating proceduras, or ather
directives

# drcepl e 3
“ Dadine POk

..................

5. After you have read the rules of behavior, click the Accept option and the
OK button to continue. A New User window displays:

S[(=/ed

Type required information o create new Admin Lser.
Al Pazswords must:

- be at leazt12 characterz long.

- contain at least 1 lowercase letter.

- contain at least 1 uppercase letter.

- cohtain at leazt 1 number.

- contain at least 1 special character.

Allowed characters | 8 &2 &7

“UszerlD : |i-:||:ua|:|min

* First Mame : |1z

*Last Mame : |DE.£‘-.|:Imin

*Mew Pazaward :

HERRERRHHH

* Confirm Pagzward :

k. Cancel

HERRERRHHH
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10.
11.

NOTE: After you use the Initial Setup button to create a user account, the button
will no longer display on the Login window. If you cannot access the |-Suite
application after the Initial Setup, either contact a user with Database Admin rights
(usually the CTSP) or call the Help Desk.

Enter the User ID you want to use to log into the |-Suite system.
Enter your First Name and Last Name.

Enter a New Password to use to log into the I-Suite system. Use the following
rules to create your password:

e The password must contain at least 12 characters.

e The password must contain at least 1 lower case letter.

e The password must contain at least 1 upper case letter.

e The password must contain at least 1 number.

e The password must contain at least 1 of the following special characters: ! # %

&N
e The Password cannot be a dictionary word.

e The Password cannot be one of the 24 previous passwords defined for the
account.

In the Confirm Password box, enter your password a second time to make sure
you entered it correctly.

Click the OK button to log into the |-Suite application.

After I-Suite opens, close the application. Then log into the system using your new
user name and password.

Before you can perform any functions within I-Suite, you must attach a database (See Attaching an
Incident Database in the Database Admin User Guide).

First Time Logging into I-Suite - Client

Follow the steps in this section if you are logging into the I-Suite client for the first time:

Only one login per user for each database is allowed. If you attempt to log into a database more than
once with the same user name, an error message displays indicating that you are already logged into the
database under that user name.

1.

Launch the I-Suite application. A Security Message displays indicating that
"Unauthorized access to this United States Government Computer System and
software is prohibited by Title 18, United States Code 1030."
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weewW arning™™*Warning™™*Warning™**Warning*™™

Inauthonzed access to this United States Government Computer System and
zoftware iz prohibited by Title 18, United States Code 10300 This statute states
that: "Whoewver knowingly, or intentionally acceszes a computer without
authorization or excesds authorized access, and by means of zuch conduct,
obtaing, alters, damages, destrovs, or dizclozes information or prevents
authorized use of data or a computer owned by or operated far the Government
of the United States shall be punished by a fine under this title or imprisonment
for not maore then 10 years, ar bath, All activities on this systern and network, may
be monitored, intercepted, recorded, read, copied, or captured in any manner
and dizclozed in any manner, by autharized perzonnel. THERE 1S MO RIGHT
OF PRIVACY IM THIS SYSTEM. System personnel may give to law enforcement
afficials any patential evidence af crimes found on this USDA computer systen.
JSE OF THIS SY'STEM BY AWNY USER, AUTHORIZED OR UNALUTHORIZED,
COMSTITUTES COMSENT TO THIS MOMITORIMG, INTERCEFTION,
RECORDIMNG, READIMG, COPYIMG, OR CAPTURING AMND DISCLOSURE.
REPORT UNAUTHORIZED USE TO AM INFORKATION SYSTEMS
SECURITY OFFICER.

Fress Yes to continue, or Mo to exit
| Yes | o
2. If you want to continue, click the Yes button. A Login window displays:

I-Suite Login

Yersion: 10.00.00

User Name |etudn:|r

EEREP PR R

Paszword

Type Server and Database or select from lists.

Database: [2009_Training v|  Advanced |

oK, Cancel | << Hide |

2. Enter your I-Suite User Name.

3. Enter your I-Suite Password.
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4. In the Server box, you can either select the appropriate server from the drop-
down list or type the name of the server.

If you type the name of the server in the Server box, you will also have to type the name of the database
in the Database box. The system will not display any names in the Database drop-down list.

5. In the Database box, either select the name of the appropriate database from the
drop-down list or type the name of the database.

6. Click the OK button to log into the I-Suite application.

7. When the Rules of Behavior window opens, indicate whether you are a Forest
Service employee or a Non Forest Service employee.

Rules of Behavior
ou must accept the Rules of Behavior prior to accessing -Suite.

™ Forest S ervice
T Man Fonest Service

™ dccept
T Dadine

8. After you have read the Forest Service or Non Forest Service Rules of Behavior,
click the Accept option and the OK button to continue logging into the system.

9. When the Reset Password window opens, enter a New Password and a
Confirm Password to change the password to your User Account. Click the
OK button to continue logging into the system.
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is. Reset Password E@

Type required information to reset password.
Al Pazswords must:

- be at least 12 characters long.

- contain at least 1 lowercase letter.

- contain at least 1 uppercase letter.

- cohtain at leazt 1 number.

- contain at least 1 special character.

Allowed characters | 8 &2 &7

“User D - fetdor

" First Mame : | fizabeth

* Last Mame : | Tydor

*Mew Pazaward :

HERRERRHHH

* Confirm Pagzward :

HERRERRHHH

k. Cancel
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Chapter 3

Logging in & Logging Out

Follow the instructions in this section to log into and out of the I-Suite system.

First Time Logging into I-Suite -Server
Follow the steps in this section if you are logging into the |-Suite server for the first time:

1. Launch the I-Suite application. A Security Message displays indicating that
"Unauthorized access to this United States Government Computer System and
software is prohibited by Title 18, United States Code 1030."

weewW arning™™*Warning™™*Warning™**Warning*™™

Inauthonzed access to this United States Government Computer System and
zoftware iz prohibited by Title 18, United States Code 10300 This statute states
that: "Whoewver knowingly, or intentionally acceszes a computer without
authorization or excesds authorized access, and by means of zuch conduct,
obtaing, alters, damages, destrovs, or dizclozes information or prevents
authorized use of data or a computer owned by or operated far the Government
of the United States shall be punished by a fine under this title or imprisonment
for not maore then 10 years, ar bath, All activities on this systern and network, may
be monitored, intercepted, recorded, read, copied, or captured in any manner
and dizclozed in any manner, by autharized perzonnel. THERE 1S MO RIGHT
OF PRIVACY IM THIS SYSTEM. System personnel may give to law enforcement
afficials any patential evidence af crimes found on this USDA computer systen.
JSE OF THIS SY'STEM BY AWNY USER, AUTHORIZED OR UNALUTHORIZED,
COMSTITUTES COMSENT TO THIS MOMITORIMG, INTERCEFTION,
RECORDIMNG, READIMG, COPYIMG, OR CAPTURING AMND DISCLOSURE.
REPORT UNAUTHORIZED USE TO AM INFORKATION SYSTEMS
SECURITY OFFICER.

Prezs ez to continue, ar Mo to exit

_te |

2. Click the Yes button to acknowledge the warning and continue with the Login
process. A Login window displays:
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I-Suite Login
Server Login Mode
Version: 10.00.00

Iratial Server
Setup

Type Server and D atabase or select from hists.

Server: j
Database: j Advanced

<< Hide |

Cancel |

3. Leave the User Name and Password boxes blank.

4. Click the Initial Server Setup button. A Rules of Behavior window displays for a
Privileged User Account.
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Rules of Behavior
“rou must accept the Rules of Behavior prior 1o accessing 1-Suite.

|

—

= Eesponsibilities for Users with
Privileged Access to Forest Service Systems

SDA Statement of Information Securiry m

| understand that, in addition to this document, | must understand and sign the Statement of
Employves Securty Responsibilties or the Statemert of Information Security Responsibilities for
Associate sers of Forest Service Systems

. underatand that | have been granted enhanced privileges in ander to perform
speciic funclions on information sy3iems that are part of a F& G55, and that these
privileges are to be used only to perform my asaigned job reaponsibilies

. will not use my privilegss to grant myself or any other person unauthonzed
privileges, or to modify any aces3s accounts, prvilegss, system configurations, o
data in an unautharized manner

* | understand frat | have a spacial duty to safeguard FE information resources, and will
implement and operate enterprise maasures to protect hose resourcas, as instucied
by technical information bullstins (M), standard operating proceduras, or ather
directives

# drcepl e 3
“ Dadine POk

..................

After you have read the rules of behavior, click the Accept option and the
OK button to continue. A New User window displays:

S[(=/ed

Type required information o create new Admin Lser.
Al Pazswords must:

- be at leazt12 characterz long.

- contain at least 1 lowercase letter.

- contain at least 1 uppercase letter.

- cohtain at leazt 1 number.

- contain at least 1 special character.

Allowed characters | 8 &2 &7

“UszerlD : |i-:||:ua|:|min

* First Mame : |1z

*Last Mame : |DE.£‘-.|:Imin

*Mew Pazaward :

HERRERRHHH

* Confirm Pagzward :

k. Cancel

HERRERRHHH
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9.
10.

NOTE: After you use the Initial Server Setup button to create a user account, the
button will no longer display on the Login window. If you cannot access the I-Suite
application after the Initial Setup, either contact a user with Database Admin rights
(usually the CTSP) or call the Help Desk.

Enter the User ID you want to use to log into the |-Suite system.
Enter your First Name and Last Name.

Enter a New Password to use to log into the I-Suite system. Use the following
rules to create your password:

e The password must contain at least 12 characters.

e The password must contain at least 1 lower case letter.

e The password must contain at least 1 upper case letter.

e The password must contain at least 1 number.

e The password must contain at least 1 of the following special characters: ! # %

&N
e The Password cannot be a dictionary word.

e The Password cannot be one of the 24 previous passwords defined for the
account.

In the Confirm Password box, enter your password a second time to make sure
you entered it correctly.

Click the OK button to log into the I-Suite application.

After I-Suite opens, close the application. Then log into the system using your new
user name and password.

Before you can perform any functions within I-Suite, you must attach a database (See Attaching an
Incident Database in the Database Admin User Guide).

Logging into I-Suite as New User

If you are a new user in the |-Suite system, follow the steps in this section to log into the I-Suite system:

1.

Launch the I-Suite application. A Security Message displays indicating that
"Unauthorized access to this United States Government Computer System and
software is prohibited by Title 18, United States Code 1030."
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weewW arning™™*Warning™™*Warning™**Warning*™™

Inauthonzed access to this United States Government Computer System and
zoftware iz prohibited by Title 18, United States Code 10300 This statute states
that: "Whoewver knowingly, or intentionally acceszes a computer without
authorization or excesds authorized access, and by means of zuch conduct,
obtaing, alters, damages, destrovs, or dizclozes information or prevents
authorized use of data or a computer owned by or operated far the Government
of the United States shall be punished by a fine under this title or imprisonment
for not maore then 10 years, ar bath, All activities on this systern and network, may
be monitored, intercepted, recorded, read, copied, or captured in any manner
and dizclozed in any manner, by autharized perzonnel. THERE 1S MO RIGHT
OF PRIVACY IM THIS SYSTEM. System personnel may give to law enforcement
afficials any patential evidence af crimes found on this USDA computer systen.
JSE OF THIS SY'STEM BY AWNY USER, AUTHORIZED OR UNALUTHORIZED,
COMSTITUTES COMSENT TO THIS MOMITORIMG, INTERCEFTION,
RECORDIMNG, READIMG, COPYIMG, OR CAPTURING AMND DISCLOSURE.
REPORT UNAUTHORIZED USE TO AM INFORKATION SYSTEMS
SECURITY OFFICER.

Fress Yes to continue, or Mo to exit
| Yes | o
2. If you want to continue, click the Yes button. The Login window displays:

I-Suite Login

Yersion: 10.00.00

Uzer Mame |Etud|:|r

Pazzwaord

EEREP PR R

Type Server and D atabase ar select from lists.

Database: [2009_Training v|  Advanced |

0K, — | << Hide |

3. If needed, click the More>> button to display additional fields.

4. Enter your User Name.
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5. Enter your temporary Password.

If you enter an incorrect password three consecutive times, the user account will be locked. If this occurs,
contact your system administrator.

5. From the Server drop-down list, select the (LOCAL)\ISUITE2Server.
6. Click the OK button to log into the I-Suite application.

7. When the Rules of Behavior window opens, indicate whether you are a Forest
Service employee or a Non Forest Service employee.

Rules of Behavior

ou must accept the Rules of Behavior prior to accessing -Suite.

™ Forest S ervice
T Man Fonest Service

™ dccept
T Dadine

8. After you have read the Forest Service or Non Forest Service Rules of Behavior,
click the Accept option and the OK button to continue logging into the system.
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9. Click the OK button to display the Reset Password window:

. Heset Password E@@

Type required information to reset password.
Al Pazswards must:

- be at leazt 12 characters long.

- contain at least 1 lowercaze letter.

- contain at least 1 uppercaze letter.

- cohtain at least 1 number.

- contain at least 1 special character.

Allowed characters: | # 2 &7 _

“Uzer D | etudor

* First Hame : |Elizal:ueth

* Last Name : [T ydor

HERRERRHHH

*Mew Pazsword ;

HERRERRHHH

* Confirm Pagzword

k. Cancel

10. In the New Password box, enter your new password. Use the following rules to
create your password:

The password must contain at least 12 characters.
The password must contain at least 1 lower case letter.
The password must contain at least 1 upper case letter.
The password must contain at least 1 number.
The password must contain at least 1 of the following special characters: ! #
% &
The password cannot be the same as the temporary password.
e The Password cannot be a dictionary word.
e The Password cannot be one of the 24 previous passwords defined for the
account.
8. In the Confirm Password box, type your password a second time to make sure
you entered it correctly.

9. Click the OK button to log into the I-Suite application.

Logging into I-Suite

Follow the steps in this section to log into the I-Suite application after your login and password are
defined:

|On|y one login per user for each database is allowed. If you attempt to log into a database more than
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once with the same user name, an error message displays,indicating that you are already logged into the
database under that user name.

If you attempt to login to a user account with an invalid Password five consecutive times, the user
account will be disabled. If this occurs, you will need to contact your system administrator and ask them to
enable the user account.

1. Launch the I-Suite application. A Security Message displays indicating that
"Unauthorized access to this United States Government Computer System and
software is prohibited by Title 18, United States Code 1030."

=W arning™**Warnning*™*Warning*™**Warning**

IInautharized accezs to thiz United States Government Computer Spztem and
zoftware iz prohibited by Title 18, United States Code 1030, This statute states
that: “Whoewver knowingly, or intentionally accezses a computer without
authorization or exceeds authonized access, and by means of such conduct,
obtaing, alters, damages, destrovz, or disclozes information ar prevents
authorized uze of data or a computer owned by or operated for the Government
af the United States shall be punizhed by a fine under thiz title or imprizonment
for not more then 10 years, or both. All activities on this spstem and netwark, may
be monitored, intercepted, recarded, read, copied, ar captured in any manner
and dizclozed in any manner, by authonized personnel. THERE 15 MO RIGHT
OF PRIVACY [N THIS SYSTEM. System perzonnel may give to law enforcement
officialz any patential evidence of crimes found on thiz USDA computer system.
JSE OF THIS SYSTEM BY AMY USER, AUTHORIZED OR UMNALUTHORIZED,
COMSTITUTES COMSEMNT TO THIS MOMITORIMG, INTERCEFTIOMN,
RECORDIMG, READIMG, COPYIMG, OR CAPTURING AMD DISCLOSURE.
REPORT UMAUTHORIZED USE TO AM INFORMATION SYSTERMS
SECURITY OFFICER.

Prezs Yes to continue, ar Ma to exit

..... T Mo
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2. The Login window displays:

I-Suite Login
Server Login Mode
Version: 10.00.00

I1zer Mame |

Paszword |

Type Server and Database or select from lists.

Server: | j
Database:| j fdvanced |

oK, Cancel | << Hide |

3. Enter your I-Suite User Name.

4. Enter your |I-Suite Password.

If you enter an incorrect password three consecutive times, the user account will be locked. If this occurs,
contact your system administrator.

5. Click the OK button to log into the I-Suite application

Passwords expire every 60 days. If the password for your user account will expire in three or less days, a
message displays indicating that the password is about to expire. To change your password at that time,
click the Change Password button. If you do not want to change your password at that time, click the
Cancel button.

If the password for your user account has expired, a message displays indicating that your password has
expired. When you click the OK button, the Reset Password window opens. You must define a new
password before you can access the I-Suite system.

Logging into I-Suite After Your Password is Reset

Follow the steps in this section to log into I-Suite after your password is reset:

Occasionally, the DB Admin may need to reset your password. When this occurs, the DB Admin will give
you a temporary password to use the next time you log into I-Suite. You will then need to create a new
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|password to complete the log in process.

1. Launch the I-Suite application. A Security Message displays indicating that
"Unauthorized access to this United States Government Computer System and
software is prohibited by Title 18, United States Code 1030."

=W arning™**Warnning*™*Warning*™**Warning**

IInautharized accezs to thiz United States Government Computer Spztem and
zoftware iz prohibited by Title 18, United States Code 1030, This statute states
that: “Whoewver knowingly, or intentionally accezses a computer without
authorization or exceeds authonized access, and by means of such conduct,
obtaing, alters, damages, destrovz, or disclozes information ar prevents
authorized uze of data or a computer owned by or operated for the Government
af the United States shall be punizhed by a fine under thiz title or imprizonment
for not more then 10 years, or both. All activities on this spstem and netwark, may
be monitored, intercepted, recarded, read, copied, ar captured in any manner
and dizclozed in any manner, by authonized personnel. THERE 15 MO RIGHT
OF PRIVACY [N THIS SYSTEM. System perzonnel may give to law enforcement
officialz any patential evidence of crimes found on thiz USDA computer system.
JSE OF THIS SYSTEM BY AMY USER, AUTHORIZED OR UMNALUTHORIZED,
COMSTITUTES COMSEMNT TO THIS MOMITORIMG, INTERCEFTIOMN,
RECORDIMG, READIMG, COPYIMG, OR CAPTURING AMD DISCLOSURE.
REPORT UMAUTHORIZED USE TO AM INFORMATION SYSTERMS
SECURITY OFFICER.

Prezs Yes to continue, ar Ma to exit

..... T Mo
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2. Launch the I-Suite application. The Login window displays.

I-Suite Login
Server Login Mode
Version: 10.00.00

Ilzer Mame |

Pazzwaord |

Type Server and D atabase ar select from lists.

Server; | j
Database:| j Advanced |

0K, — | << Hide |

3. Enter your User Name and temporary Password. Then click the OK button. The
Reset Password window displays.

. Reset Password E@@

Type required information to reset password.
Al Pazswords must:

- be at least 12 characters long.

- contain at least 1 lowercase letter.

- contain at least 1 uppercase letter.

- cohtain at leazt 1 number.

- contain at least 1 special character.

Allowed characters | 8 &2 &7

“User D - fetdor

" First Mame : | fizabeth

* Last Mame : | Tydor

*Mew Pazaward :

HERRERRHHH

HERRERRHHH

* Confirm Pagzward :

k. Cancel
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4. Inthe New Password box, enter your new password. Use the following rules to
create your password:

The password must contain at least 12 characters.

The password must contain at least 1 lower case letter.
The password must contain at least 1 upper case letter.
The password must contain at least 1 number.

The password must contain at least 1 of the following special
characters: ' # % & " _

The password cannot be the same as the temporary password.
The Password cannot be a dictionary word.

The Password cannot be one of the 24 previous passwords defined for
the account.

4. Inthe Confirm Password box, enter the password a second time to make sure it
was entered correctly.

5. Click the OK button to reset your password.

Logging Out of I-Suite

From the File menu, select the Exit option.
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Common Features

This section describes some of the features that are common to all areas of the I-Suite system:
Injury/lliness

Menus
The following drop-down menus display at the top of the |-Suite windows:

File Menu
The following options are available in the File menu in all modules:

e Open Database - Opens an incident database in I-Suite.
e Print - Prints the grid in the open module or a report selected on the Reports
window.

[The Print option is not available in the Database Admin module.

o Refresh Data - Refreshes the data on your window.
o Exit - Closes the I-Suite application.

The following options are available in the File menu when the AP module is open:

New Form - Creates a new form.

Close Form - Closes an open form.

Save - Saves a form.

Save All - Saves all open forms.

Export - Exports a form to a PDF file.

Export Plan - Exports an entire plan to one or more PDF files.
Print Preview - Previews the form.

Print Preview Plan - Previews an entire plan.

Print Current Form - Prints the current form that is open.
Print Plan - Prints an entire plan.

Modules Menu
The following options are available in the Modules menu:

¢ Database Admin - Opens the Database Admin Module.
e Data Admin - Opens the Data Admin Module.
¢ Resources - Opens the Resources Module.
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e Cost - Opens the Cost Module.

Supply - Opens the Supply Module.

IAP - Opens the Incident Action Plan Module.
Demob - Opens the Demob Module.

Time - Opens the Time Module.

Injury/lliness - Opens the Injury/lliness Module.

Filters Menu
Select an option from the Filters drop-down menu to filter the Resources grid by:

Aircraft
Crews
Equipment
Overhead

All

All Personnel

|The Filters menu displays in all modules except |AP.

Reports Menu
Select an option from the Reports menu to print the following types of reports:

Cost Reports
Demob Reports
Plans Reports
Supply Reports
Time Reports
Custom Reports

¢ Injury/lliness Reports

Tools Menu
The following options are available in the Tools menu in all modules:

e Options - Define the settings for the different modules in I-Suite.

The settings you can change in Options depends on the permissions that are assigned to you in the I-
Suite system.

¢ Quick Stats - Quickly view Stats in the I-Suite system.
e Change Password - Change your |-Suite password.

The following options are available in the Tools menu when the AP module is open:

Copy Form - Copies an existing form to create a new one.
Copy Plan - Copies an existing plan to create a new one.

Spell Check - Spell checks a form.

Form 203 Template - Defines the template for the ICS 203 form.
Form 204 Template - Defines the template for the ICS 204 form.
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e Final - Finalizes a form.
e Master Frequency - Creates a Master Frequency List.

Help Menu
The following options are available in the Help menu:

e |-Suite Help - Opens Help information for the I-Suite application.
e About - Displays version information for I-Suite.
e Support - Displays contact information for the HelpDesk.

Time Menu
The Time menu only displays when you are in the Time module. The following options are available in
this menu:

e Admin Office For Payment - Adds administrative office information to |-Suite.
e Contractor - Adds contractors and agreements to I-Suite.

Cost Menu
The Cost menu only displays when you are in the Cost module. The following options are available in
this menu:

e Acres Burned - Defines acres burned information.

e Cost Analysis Benchmark Setup - Sets up the data to use in the Cost Analysis
Report you can print on the Cost Report window.

¢ Divisions - Defines a division for Cost Apportionment purposes.

e Graphs - Creates standard or custom Cost Graphs.

e Accruals - Creates an Accrual Extract.

¢ Projections - Creates Cost Projections.

¢ Rates - Defines Rate Areas and Rates.

Edit Menu
The Edit menu only displays when you are in the IAP Module. The following options are available in this
menu:

e Copy - Copies a form.

Cut - Cuts text that is highlighted in a form.

Paste - Pastes text that was cut or copied into a form.
Delete Form - Deletes a form.

Format - Changes the font style.

View Menu
The View menu only displays when you are in the IAP module. The following options are available in this
menu:

e Form - Displays all forms in the Tree View.
¢ Individual Form - Displays only specific forms in the Tree View.
¢ Plan - Displays plans in the Tree View.

Shifts Menu
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The Shifts menu only displays when you are in the IAP module. The following options are available in
this menu:

e Define Shifts - Adds shifts to IAP.

Window Menu

The Window menu only displays when you are in the IAP module. This menu contains a list of the forms
that are currently open. Select a listed form, to make that the active form in the window. Select the Close
All Forms option to close all forms that are open.

Supply Menu
The Supply menu only displays when you are in the Supply Module. The following options are available
in this menu:

e Release (Permanent) - Permanently releases supply items to another location,
such as a cache or another incident.

Add/Edit Location - Adds or edits a location.

Add/Edit Supply Items - Adds or edits a Supply item.

Transfer (At Incident) - Transfers a Supply item from one resource to another
Import Shipment --Import Supply shipment.

Inventory - Allows the user to manually change inventory counts.

Toolbars

The following toolbars display at the top of the I-Suite windows:

Main Toolbar
The Main toolbar contains two separate types of buttons:

Module Buttons
The Module buttons open modules in the I-Suite system. These buttons are located on the left side of
the Main toolbar. The following example identifies the buttons and the modules that they open:

Resources Cost Supply

!
L

Time AP Demob

i

&

Action Buttons
The Action buttons perform an action in one of the I-Suite modules. These buttons are located on the
right side of the Main toolbar. The following example identifies the buttons and the action that occurs:
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Reports F'rjview Edit Refresh

@&:T*mx

Print Add Delete

Filter Toolbar

The Filter toolbar displays beneath the Main toolbar. Click the buttons in this toolbar to filter the
information in the Resources grid. The following example identifies the buttons in this toolbar and the
resources that display in the grid when you click the buttons:

All Reil:uurcea Crews Overhead Exclude Demobed
£] [‘t@ [ Exclude Demobed
@ ‘ ‘ ‘@‘ r% ﬁﬁ [ Exclude Filled

Adrcraft Equipment All Personnel Exclude Filled

\When the Demob module is open, a Demobed Only checkbox displays beneath the Exclude Filled
checkbox. This option only displays in the Demob module.

Resources Toolbar
The Print T-Card Labels button displays to the right of the Filter toolbar when you are in the Resources
module. Click this button to print T-Card Labels. The following is an example of this button:

T

The Group Check-In and No Grouping buttons display to the right of the Print T-Card Labels button
when you are in the Resources module. Click the C button to open the Manage Resources window and
select the users to check-in as a group. Click the N button to turn off the grouping option.

v

Time Toolbar
The Time toolbar displays to the right of the Filter toolbar when you are in the Time module. The
following example identifies the buttons in this toolbar:
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Puost Time Enter as Tab

T +

Treat enter az
¥ 1 %

Adjustments Frint Invoice

e Post Time - Post time for a resource.

e Adjustments - Make adjustments to the time for items such as Quarters and
Lodging, Meals, Travel, etc.

e Treat enter as Tab - If you would like the Enter key to work as the Tab key when
moving between options, click to check the Treat enter as Tab checkbox.

e Print Invoice - Print either an OF 288 or an OF 286, depending on the resource
you have selected.

Cost Toolbar
The Cost toolbar displays to the right of the Filter toolbar when you are in the Cost module. The
following example identifies the buttons and options in this toolbar:

‘ e i Rate Area i Rasciries Ssezied b Grig

;E-- A Tatal Rate Area Cost Processzes | Besources Selected In Grid
i $ Rallup |Default j |Ereate Cost, Update Actuals & He-ej Bun

TotalBolluo LU FTOCSE3s3 =
a ug

oy R

In'.:
i

e Show Costs - Click this button to display the Manage Cost grid at the bottom of
the window. This grid contains a list of Daily Costs for a selected resource.

¢ Archive Resources - Click this button to archive resources, so they are not
included when Cost Processes are run.

e Total - When this option is checked, the total cost displays for the selected
resource, as well as any rollup costs.

¢ Flow Down - When this option is checked, the flow-down feature for the Manage
Cost grid occurs. Flow-down allows you to change the Quantity, Unit Cost,
Units, Rate Type or Division in the Manage Cost grid. When that information
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changes, the system changes (flows-down) the information in all of the Daily
records below it that are not locked.

e Rate Area - To use a rate area other than the Default Standard rate area, select
the appropriate rate area from this drop-down list.

e Cost Processes - Select a process from this drop-down list and click the Run
button to run that process.

e Resources Selected in Grid - When this checkbox is checked, you can run Cost
Processes for one or more resources selected in the grid.

¢ Run - Click this button after you have selected a Cost Process to run that
process.

IAP Toolbar
The IAP toolbar displays beneath the Main toolbar when you are in the Incident Action Plan module.
The following example identifies the buttons in this toolbar:

Create hanage
Mew Forrm Sawve All Cu:upiFDrr‘n Bwv Plan hdark Final Halics

0-|8[% v @ wCOE- &l sz
Save Spell Copy Plan Manage Bold Underline
Check B Form

e Create New Form - Displays a list from which you can select the form you want to
create.

e Save - Saves the form.

e Save All - Saves all open forms.

e Spell Check - Checks the form for spelling errors.

e Copy Form - Displays a list of forms you can copy.

e Copy Plan - Displays a list of plans you can copy.

e Manage By Plan - Displays all forms grouped by an Incident Action Plan.

e Manage By Form - Displays all forms grouped by form number. You can also use
this button to only display a certain type of form.

e Mark Final/Mark Draft - When the form is marked Draft, this button changes it to
Final. When the form is Final, this button changes it back to Draft.

e Bold - Bolds text selected in a form.
e [talic - Italicizes text selected in a form.

e Underline - Underlines text selected in a form.
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Supply Toolbar
The Supply toolbar displays to the right of the Filter toolbar when you are in the Supply module. The
following example identifies the buttons in this toolbar:

s |zzUe
R eturns

e Issue - Issue supply items.

Add
Supply
[tem

|zzLe
Report

|hcident
Card

Add/Edit
Location

Wigw
Histony

Irmpart

lze Shipment

e Issue Returns - Return supplies issued to a resource or location.
¢ Receive - Receive supply items.

e Import Shipment -- Import supply shipment

¢ View History - View a history of supply items that were issued.

e Add/Edit Location - Add or edit locations that are either internal or external to the
incident.

e Add Supply Item - Add items to the Supply list.
¢ Incident Card -- Links supply card to a resource
¢ Issue Report -- Report of currently assigned supplies

Demob Toolbar
The Demob toolbar displays to the right of the Filter toolbar when you are in the Demob module. The
following example identifies the buttons in this toolbar.

Ternative | Avadsble
F DI N Posler | [of Redeate

e P Button - Click a group of resources in the grid. Then click the P button to change
the status of the selected group to Pending. .

A Traved | Check | Actual | Ground | W Resowces Selected In Gid
Riequeast Ot Demob | Supperd

e D Button - Click a group of resources in the grid. Then click the D button to
change the status of the selected group to Demobed.

When you click either the P or D button, the Save button changes to Save & Next. You must click this
button to save the changed status to the resource. When you click the Save & Next button, the changes
are saved and the next selected record displays.

¢ N Button - If you have used the P or D button to change the status of a group of
resources, you can change the status back by clicking the N button. You must
click the N button before saving any changes to the resources. If you saved the
status change to a resource, it will not be changed back to the original status
code.
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e Demob Report Buttons - Prints the following reports when you click the
respective buttons:

o Tentative Poster

o Available for Release
o Air Travel Request

o Check Out

o Actual Demob

o Ground Support

e Resources Selected in Grid - When this checkbox is checked and you click a
Report Button, the report is generated for the resource selected in the grid.

Injury/lliness Toolbar

The Injuryl/lliness toolbar displays to the right of the Filter toolbar when you are in the Injury/lliness
module. The following example identifies the buttons in this toolbar.

Show Injury Fesources with Previous
IIInessfetaiIs iew History Injuriesfliinesses
Defaults | HiEw Stats [ Previous Injury / liness
Hiztary Baze
Set Defaults Stats Base

e Show Injury/lliness Details - Display the Manage Injury/lliness area.

e Defaults - Set defaults for the Injury/lliness module.

¢ View History - View a history of injuries and ilinesses.

o Stats Base - Define statistics to use in the Injuries and Frequency report.

¢ Previous Injury/lliness - Only display resources with previous injury or illness
records in the grid.
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Chapter 6

Accessing Help

This section explains how to access I-Suite help information. There are several methods you can use to
receive Help for the | Suite Application:

I-Suite Application Help

Help is available within the I-Suite application. To access the I-Suite Application Help:
1. Select the Help drop-down menu at the top of any |-Suite window.
2. When the sub-menu displays, select the I-Suite Help option.

For additional help, contact the I1-Suite Help Desk at (866) 224-7677.

Contact information for the I-Suite HelpDesk is available by selecting the Support option listed under the
Help Menu in |-Suite.

I-Suite Website

The |-Suite Website (http://isuite.nwcg.gov) contains a wide variety of I-Suite documentation,
downloads and updates, including:

e Software Downloads - Click the Download link to access software downloads.
e Updates - Click the Download link to access software updates.

e User Guides - Click the User Support link to access User Guides. These guides
display in a PDF format.

¢ Quick Reference Cards - Click the User Support link to access Quick Reference
Cards in a PDF format.

¢ Training Material - Click the Training link to access Training Material. The
Training Manuals display in a PDF format.

\When viewing a PDF file in Adobe Acrobat, you can use the File/Save As option to save the file to your
computer.

[To access other online help on the isuite.nwcg.gov web site, click the Bugs & Tips option to open the |
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Bugs & Tips Web page. |
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Chapter 7

General Instructions

This section contains general instructions for using the I-Suite system.

Security

Make sure private information is kept confidential. Private information includes Social Security Numbers
(SSNs) and IRS Federal Employer Tax ID Numbers (EINs),

For more information about clearing out SSNs and EINs, see Purging Social Security Numbers in the
Database Admin User's Guide. For information about changing your password, see Changing an I-Suite
Password in the Database Admin User's Guide.

Opening an I-Suite Module
1. Click the Modules menu at the top of the window.

2. Click a module listed in the Modules menu to open it.

IYou can also click a module button in the toolbar at the top of the I-Suite window to open the module. |

Managing All Incidents as One
If you want to manage all of the incidents as if they were one, follow these steps:

1. At the top of the I-Suite window, click to check the Manage All Incidents As One
checkbox.

2. When the Manage All Incidents as One message window displays, click the OK
button.

When the Manage All Incidents as One option is selected and you are adding a resource, an Incident
Name drop-down list is available on the Manage Resource - Add Mode window. Verify that the correct
Incident Name and Account Code are selected for the new resource.

Managing Incidents Separately

If you want to manage all incidents separately, follow these steps:
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1. At the top of the I-Suite window, click to uncheck the Manage All Incidents As
One checkbox, if it was selected.

2. From the Incident drop-down list, select the appropriate incident.

When managing incidents separately, verify that the correct incident displays in the Incident box at the top
of the Main I-Suite window.
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Chapter 8

I-Suite Module Descriptions

This section describes the primary purposes of each of the I-Suite modules:

The modules you can access in |-Suite depend on the permissions assigned to the you in the I-Suite
system.

Database Admin

You can perform the following functions in the Database Admin module:

Create an Incident Database
Attach an Incident Database
Detach an Incident Database
Backup an Incident database
Restore an Incident Database
Copy an Incident Database
Rename an Incident Database
Define I-Suite Users and Roles
Import ROSS Data into |-Suite.
Create a Data Repository File
Export Financial Data

Export Injury/lliness Data
Purge SSN/EINs from the Database
Merge Incident Databases

Data Admin

You can perform the following functions in the Data Admin module:

¢ Define Incidents
e Define Accounting Codes
e Define Lookup Tables

Resources
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The primary purpose of the Resources module is to provide a standardized method to check-in resources
when they arrive at an incident. This makes record keeping and status assessment easier.

You can perform the following functions in the Resources module:

Add and Edit Resource Data

Roster Crews and Equipment

Create Strike Teams and Task Forces

Generate Various Incident Reports (including the 209 Report, Section Report,
Qualifications Report, and Daily Incident Report)

Demob

The primary purpose of the Demob module is to assist in pre-planing and demobilization of resources.
You can perform the following functions in the Demob module:

Demob Planning

Define Tentative Release Information.
Define Actual Release Information.
Generate Demob Reports.

Incident Action Plan (IAP)

IAP uses the data in the I-Suite database to produce the Incident Action Plan for the incident. You can
perform the following functions in the IAP module:

Create a Master Frequency List

Define Shifts

Create Incident Action Plans Using ICS202, ICS203, ICS204, 1CS205, ICS206
and 1CS220 forms

Time

The primary purpose of the Time module is to track time and create pay documents, including the
Emergency FireFighter Time Report (OF-288) and the Emergency Equipment Use Invoice (OF-286). You
can perform the following functions in the Time module:

Post Personnel Time

Post Crew Time

Post Contracted Resource Time
Post Adjustments

Print Invoices

Print Time Reports

Cost
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The primary purpose of the Cost module is to track costs for individual resources. The system creates an
estimated cost record for every resource for every day. The Cost user can then analyze, manipulate, and
create outputs of this information in a variety of report formats.

You can perform the following functions in the Cost module:

Update Daily Cost Records

View Daily Cost Records

Define Cost Rates

Define Acres Burned

Define Cost Apportionment Information
Create Cost Projections

Create Cost Graphs

Create Accrual Extracts

Generate Cost Reports

Custom Reports

The primary purpose of Custom Reports is to use I-Suite data to create reports that are not available in
the Standard Reports. You can perform the following functions in the Custom Reports module:

e Create custom reports with the Report Designer
e Create custom reports with the Advanced Report Designer
e Preview, Print, Export, Import, Edit, Delete and Copy custom reports

Supply

The primary purpose of the Supply module is to track supply items at an incident. You can perform the
following functions in the Supply module:

Issue Supply Items

Return Issued Supply Items
Receive Supply Items

Track Supply Inventory

View History of Issued Supplies
Print Supply Reports

Injury/lliness

The primary purpose of the Injury/lliness module is to track injuries and illnesses that occur on an
incident. You can perform the following functions in the Injury/lliness module:

e Add injury and iliness information for resources
e Edit injury and illness information for resources
Delete injury and illness information for resources
View injury and iliness histories
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¢ Define statistics to use in the Injuries and Frequency report

e Print injury/iliness reports
[ ]
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Chapter 9
Working with Grids

Resource information in I-Suite displays in grids. There are several different ways you can filter
information in the grids. This section identifies all of the methods you can use.

Filter Buttons

Click the following buttons in the Filter toolbar to only display the identified types of resources:

All Resources
Click this button to display all of the resources in the grid.

©

Aircraft
Click this button to display only aircraft resources in the grid.

Crew
Click this button to only display crew resources in the grid.

¥

Equipment
Click this button to only display equipment resources in the grid.

B

Overhead
Click this button to only display overhead resources in the grid.

b
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All Personnel
Click this button to display all personnel resources in the grid.

il

[The Add and Edit buttons are disabled when the All Personnel filter is selected. |

[The All Personnel filter is not available in the Cost module. |

Exclude Demobed

To remove resources that were already demobilized from the grid, click to check the Exclude Demobed
checkbox.

Exclude Filled

To remove resources with a Filled status from the grid, click to check the Exclude Filled checkbox.

Filter Bar

A Filter Bar is located directly above the grid. Each of the empty boxes in the filter bar corresponds to
headings in the grid. If you type a term in a filter box, I-Suite only displays those resources that match the
filter term. For example, if you enter AIR above the NAME column in the grid, only those resources with
names that begin with AIR display in the grid.

® | B8R | T
— ¢
|
Request Murmber Kind Desc
+ [ 298 AIR ATTALK - NZF - AA507 - COB |FIXED WING, AR b
B AIRTAMEER - 05 AIRTAMEER F i
N AIRTAMKER - 05 AIRTAMEER "
| EREQ AIRTAMKER - 05 AIRTAMKER /
B AIRTAMKER - 0B AIRTAMKER B
N .;33 AIRTANKER -06 AIRTANKER [
x._\- \‘--\__.__...___ _.-L_.\-J'Nb_' ..u,«-«,‘-_{.;ﬁif 7 fx_\\ o Mn-r.;qna--ku_h‘f/_a,.

'You do not have to enter an entire search term. When you enter the first few characters of a term for any
column, all entries that begin with those characters display in the grid.

% Wildcards

You can use the % wildcard to filter the grid based on a word within the column you are filtering. For
example, enter %Tanker in the Name filter box to display all resources with the word Tanker in their
name.
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If you entered the search term Tanker without the % wildcard, I-Suite would only display those names
that began with the word Tanker.

Clear Filter Bar
To clear the Filter Bar, click the Clear Filter Bar button located to the left of the Filter Bar.

v

Sorting the Grid

To sort data in a grid, click a column heading. The grid is sorted based on the column that you select.
When you click the heading once, the data is sorted in Ascending order. When you click it a second
time, it is sorted in Descending order.

To use multiple columns to sort the data in the grid, hold down the Shift key and click each column
heading you want to include in the sort.

Printing the Grid

After you have filtered and sorted the grid, you can print the grid by clicking the Print button in the Main
toolbar or selecting the Print option from the File menu.
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Chapter 10
Options

This section explains how to set options for I-Suite. The following information is included in this section:

Selecting General Options (See Page 55)

Selecting Resource Options (See Page 57)

Defining Resource Label Parameters (See Page 59)
Selecting Time Options (See Page 60)

Selecting IAP Options (See Page 62)

Selecting Cost Options (See Page 63)

Selecting Demob Options (See Page 65)

Selecting Demob Checkout Options (See Page 66)
Selecting Travel Questions for Demob (See Page 67)
Selecting Supply Options (See Page 69)

Selecting Injury/lliness Options (See Page 70)

[Only those modules for which you have user rights are available on the Options window.

Selecting General Options

This section explains how to set General Options for the I-Suite application:

Changing Grid Colors
Follow the steps in this section to change the colors that display in the grids within the I-Suite system:

1. From the Tools drop-down menu, select Options to open the Options window.
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General | Fesources | Time | 1&P | Cost | Demob | Supply | Injurydlness |
GGrid Colorg
Sample Grid

1 |FH C1 |R1C2 R1C2

21R2 |:'| R2C2 Rz C2

. FR3ICT R3C2 R3cCz

. 41R4 1 R4 C2 R4 C2

. AIRELC RAC2 R&C2

. B|RELC1 REC2 R&CZ

Color

- Reset Calarz

Data Saved
v Show Data Saved Message Bos

Cancel | | Save |

2. Click the General tab to select it.

3. From the Grid Area drop-down list, select the area of the grid for which you want
to change the color.

4. Click the Color box to open a Color window.

5. Click the color that you want to use. Then click the OK button to apply it to the
grid.

|VVhen you change the color, you can preview the change under the Grid Colors area on the General tab. |

6. Repeat steps 3 - 5 for each grid area that you want to change.

7. When you have finished defining the grid colors, click the OK button on the
Options window to apply your changes.

Data Saved
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Follow the steps in this section to either show or hide the Data Saved message box when the Save
button is clicked in any module in I-Suite:

1. From the Tools drop-down menu, select Options to open the Options window.
2. Click the General tab to select it.

3. If you want the Data Saved message to display when saving a record in |-Suite,
click to check the Show Data Saved Message Box checkbox.

If you do not want the Data Saved message to display when saving a record in |-
Suite, click to uncheck the Show Data Saved Message Box checkbox.

4. Click the OK button to save your changes and close the Options window.

Selecting Resource Options

Follow the steps in this section to select the options to use in the Resources area of the I-Suite system:

1. From the Tools drop-down menu, select Options to open the Options window.
2. Click the Resources tab.

3. Click the lower Resources tab.
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il Options

Fesources | Labels |
Rezource Grid Columns

v| Request Mumber Y

v M ame

v Find Desc

w| Status

v Adenicy

v Home it

MR elease Date
[ncident Mumber
[ncident Mame
Checkin Date
Checkin Time
Releaze Time
MHurnber Personnel

bove Up

kove Down

Shion
Hide

il

General | Resources | Time | 1&P | Cost | Demob | Inju/llness |

"Other Column Titles

B=1E3

Other 1: Other 1
Other & Other 2
Other 3: Other 3

Default Check-in D ate and Time

" Spstem Date

{* Blank

Additional Kindz used for QuickStats

AIRCRAFT BEASE RADID OPR

Configuratian >
Original Order Reguest *
Drerob City
Demob State ﬂ
Jetport b Kind/Pasitian -
] | Cancel | Clear Delete |

4. Under Resource Grid Columns, hold down the Ctrl key and click to highlight
each of the columns you want to select.

5. If you want to remove the selected columns from the Resource grid, click the

Hide button.

If you want to display the selected columns in the Resource grid, click the Show

button.

Each column with a checkmark in the checkbox next to it is included in the grid. When you click the Show
button, it places a checkmark in the checkbox next to the selected column. When you click the Hide
button, it removes the checkmark from the checkbox. You can also click the checkbox next to a listed
column to either Show or Hide it.

6. To adjust the order in which the columns display in the Resource grid, click a
column listed under Resource Grid Columns. Then click the Move Up or Move
Down button to move the column.

'The order in which the columns display under Resource Grid Columns is the order in which they will

display in the grid.
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7. If you want to change the titles that display for the Other columns, type the new
name in the "Other" Column Titles box. For example, to change the name of the
Other 1 column, enter the new name in the box next to Other 1.

When the title for the Other columns are changed on the Resources tab, the changes are saved to the
database. This means that all users will see the changes.

8. If you want to automatically insert the system date and time for the check-in, click
the System Date option in the Default Check-In Date and Time area.

If you want to leave the check-in date and time blank, click the Blank option in the
Default Check-In Date and Time area.

[Each user can define the Default Checkin Date and Time they want to use in |-Suite.

9. To add additional Kind Codes for Quick Stats, select the code from the
Kind/Position drop-down list. Then click the Save button.

To remove Kind Codes for Quick Stats, click the code listed in the Additional
Kinds used for Quick Stats box. Then click the Delete button.

When you add additional Kind Codes for Quick Stats, the changes are saved to the database. This
means that all users will see the changes.

10. When you have made all of your changes, click the Save button to save any
changes. Click the OK button to close the Options window.

Defining Resource Label Parameters

Follow the steps in this section to define the parameters for Resource Labels:
1. From the Tools drop-down menu, select Options to open the Options window.
2. Click the Resources tab.

3. Click the Labels tab.
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General | Resources | Time | 1&P | Cost | Demob | Supply |

Special Purpoze Label Printer | “hhphLazen eth ﬂ

Label Farmat

First Fontzize IT
Second Fontsize Ia_
Top Offzet |-|_
Left Offzet |-|_

Font Mame m

EEERGPREY AN I et DR G

4. From the Special Purpose Label Printer drop-down list, select the label printer to
use.

5. In the First Fontsize box, type the font size to use for the first line on the label.

6. Inthe Second Fontsize box, type the font size to use for the second line of the
label.

7. Inthe Top Offset box, type the print offset to use at the top of the label. This
identifies the amount of space to insert at the top of the label. Use this option,
along with the Left Offset option, to define where to print the text on the label.

8. In the Left Offset box, type the print offset to use on the left side of the label. This
identifies the amount of space to insert on the left side of the label. Use this
option, along with the Top Offset option, to define where to print the text on the
label.

9. From the Font Name drop-down list, select the type of font to print on the label.

10. Click the OK button to save any changes made to the label settings.

Selecting Time Options

Follow the steps in this section to select the options to use in the Time area of the I-Suite system:
1. From the Tools drop-down menu, select Options to open the Options window.

2. Click the Time tab to select it.
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Fezource Grd Columng

MR equest Mumber

v Mame

v Statuz

v K.ind

v Actual Releaze Date

v Adency

v| Configuration
¥.ind D escrption
Harne Lnit
[nizident Mame
[nizident Mumber

v| Employment Code
Contracted
Contractor Mame
Agreement
Arccounting Code
[Inique Mame
Wehicle |0

ehera es0Urces ime ozt &M Lpply riunAliness
G I | R | Ti |If-\F"|E | Demob | Supply | Irjunedll |

bove Lp

kave Daown

Show

Hide
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EEX]

ok | Cancel |

| Save |

3. Under Resource Grid Columns, hold down the Ctrl key and click to highlight
each of the columns that you want to select.

Hide button.

If you want to remove the selected columns from the Resources grid, click the

If you want to display the selected columns on the Resources grid, click the

Show button.

Each column with a checkmark in the checkbox next to it is included in the grid. When you click the Show
button, it places a checkmark in the checkbox. When you click the Hide button, it removes the checkmark
from the checkbox. You can also click the checkbox next to the column to either Show or Hide it.

5. To adjust the order in which the columns display on the Time window, click a
column under Resource Grid Columns, then click the Move Up or Move Down

button.

display in the grid.

The order in which the columns display under Resource Grid Columns is the order in which they will

6. Click the Save button to save your changes. Click the OK button to close the

Options window.
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Selecting IAP Options

Follow the steps in this section to select the options to use in the IAP area of the I-Suite system:
1. From the Tools drop-down, select Options. The Options window displays.

2. Click the IAP tab to select it.

= - [B]x

Gereral | DB Admin | Resources | Time |IA.P| Cogt | Demob | Suppl | Injumdlness |

FResource Drop Down Lists Toolbar

Perzons Name Order [ Small lcons

* | ast Mame, First Name

: Yiew Options
(" First Mame Last Mame
f* Mk anage by plan

" Manage by form
[ Include Filled

Treeview Dizplay
(o Show Al

(« Selected [ncident ~ By Date [Shows Foms N
PRI Hewer Than Sele;ted D ate]
MHurnber of days prior to the l_
(" gystern date and any newer
formsz

Rezources To Display From

[u] 8 | Cancel |

3. If you want name data to display in the order last name and then first name, click
the Last Name, First Name option.

If you want the name data to display in the order first name and then last name,
click the First Name Last Name option.

Identify the order in which to display the name data before creating forms in IAP. If you change the order
after having saved some forms, the order is not changed for the already saved forms.

4. If you want to show the Filled resources that are known to be working on the
Incident, click the Include Filled option. This is a User option and once set, will
affect all databases that the user logs in to. It can be turned off and on by clicking
the check box.
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5. If you want to only show resources for the incident selected in the Incident drop-
down on the IAP window, click to check the Selected Incident option.

6. If you want to show resources for all incidents, click to check the All Incidents
option.

7. To reduce the size of the buttons in the IAP toolbar, click to check the Small
Icons checkbox.
To change the size back to large buttons, click to uncheck the Small Icons
checkbox.

8. To change the View Options, click Manage by Plan or Manage by form. Manage
by form is the default option.

9. To identify the forms to display in the Tree View on the IAP window, click one of
the following options under Treeview Display:
e Show All - Shows all saved forms.

e By Date - When you select this option, all forms with a date that is newer than
the defined date display in the Tree View.

When you select the By Date option, you must enter a date into the text box that is next to the option.
This is the date to which the application refers in order to identify the forms to include in the Tree View.

e Number of days prior to the system date and any newer forms- \When you
select this option, the application calculates the dates to display by
subtracting the number of days defined from the Current System Date. The
forms display from the calculated date forward.

\When you select the Number of Days option, you must enter a number into the text box that is next to
the option. This is the number to which the application refers in order to identify the forms to include in the
Tree View.

10. Click the Save button to apply any changes made to the IAP settings. Click the OK button to
close the Options window.

Selecting Cost Options

Follow the steps in this section to select options to use in the Cost area of the I-Suite system:

1. From the Tools drop-down menu, select Options to open the Options window.

2. Click the Cost tab to select it.
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ehera esoUrces irrE: ost &M Lipply hjuryAlliness
G | | R | Ti | &P | C |D b | Supply | Injurl |

FRezource Grid Columns

Incident Murmnber Mave Lp
Incident Mame
v| Request Mumber b ove Down
w| Mame
v/ Kind
w| fugency Shaow
| Payment Sgency "
| Horme Unit ﬁ
v Azzign D ate

v| Checkln Date
v| Actual Feleaze Date
v| Statusz
v 5T
v Bemarks
v Acorial
Accrual s
Create Daily
v| Eztimated Date of Arrival

ok I Cancel | | Save | |

3. Under Resource Grid Columns, hold down the Ctrl key and click to highlight
each column that you want to select.

4. If you want to remove the selected columns from the Cost window, click the Hide
button.

If you want to display the selected columns on the Cost window, click the Show
button.

Each column with a checkmark in the checkbox next to it is included in the grid. When you click the Show
button, it places a checkmark in the checkbox. When you click the Hide button, it removes the checkmark
from the checkbox. You can also click the checkbox next to a column to either Show or Hide it.

5. To adjust the order in which the columns display on the Cost window, click a
column. Then click the Move Up or Move Down button to move the selected
column.

The order in which the columns display under Resource Grid Columns is the order in which they will
display in the grid.

6. When you have made all of your changes, click the Save button to save the
changes. Then click the OK button to close the Options window.

[-Suite Version 13.01.00 Getting Started 64




Chapter 10:Options

Selecting Demob Options

Follow the steps in this section to select the options to use in the Demob area of the |-Suite system:

Also refer to Selecting Demob Checkout Options (See Page 66) and Selecting Travel Questions for
Demob (See Page 67).

1. From the Tools drop-down menu, select Options to open the Options window.
2. Click the Demob tab.

3. Click the lower Demob tab.

General | Resources | Time | 1P | Cost | Demob | Supply |

i Demob | CheckOut | Travel Questions |
FRezource Grd Columng

v| tctual Aeleaze Date Hide
Actual Releaze Time
Eztimated Date af Arrival

v| Estimated Time of Arrival
Rest Over Might

v Actual Feleaze Remarks
Fest Ovwer Might Femarks
Dizpatch Motified Actual Release
Mame On Picture D
Depart From Jetport
Trawvel Time

Tentative Feleaze Date Y Move Up
Tentative Releaze Time

Feturn Travel Method Move Down
Tentative Feleaze Remarks

Dizpatch Motified Tentative Release Shaw
Checkaut Farm Printed

Special Instructions

[].4 | Cancel | | Save | |

4. Under Resource Grid Columns, hold down the Ctrl key and click to highlight
each of the columns you want to select. The following columns are available:

5. If you want to remove the selected columns from the Demob window, click the
Hide button.

If you want to display the selected columns on the Demob window, click the Show
button.

|Each column with a checkmark in the checkbox next to it is included in the grid. When you click the Show |
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button, it places a checkmark in the checkbox. When you click the Hide button, it removes the checkmark
from the checkbox. You can also click the checkbox next to a column to either Show or Hide it.

6. To adjust the order in which the columns display on the Demob window, click a
column. Then click the Move Up or Move Down button to move the column.

The order in which the columns display under Resource Grid Columns is the order in which they will
display in the grid.

7. When you have made all of your changes, click the Save button to save the
changes. Click the OK button to close the Options window.

Selecting Demob Checkout Options

Follow the steps in this section to select the checkout options to use in Demob:

Also refer to Selecting Demob Options (See Page 65) and Selecting Travel Questions for Demob (See
Page 67).

1. From the Tools drop-down, select Options. The Options window displays.
2. Click the Demob tab to select it.

3. Click the Check-Out tab to select it.

General | Resources | Time | 1P | Cozt | Demob Injurp/llness |

Demob | CheckOut | Travel Questions |

Customize Checkout Form [IC5-2217]

Logizticz Sechion Finance Section

[ Supply Unit [w Time Lnit

[v Communications L nit

[v Facilities Lnit Other Section

[ Ground Support Uit [ Securty Unit

v [w ashing Station

Planning Section |

[ Documentation it

[v Cremaob Unit

ok I Cancel Save
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4. Under the Logistics Section, click to check each of the options you want to check
in the Logistics section of form ICS-221. You can include:
e Supply Unit
e Communications Unit
e Facilities Unit
e Ground Support Unit
5. If you want to check the Documentation Unit in the Planning Section of the ICS-
221 form, click to check the Documentation Unit checkbox.

6. If you want to check the Demob Unit in the Planning Section of the ICS-221
form, click to check the Demob Unit checkbox.

7. If you want to check the Time Unit in the Finance Section of the ICS-221 form,
click to check the Time Unit checkbox.

8. If you want to checkthe Security Unit in the Other Section of the ICS-221 form,
click to check the Security Unit checkbox.

9. To include additional information in the Other Section of the ICS-221 form, type
the name of the option in either of the blank boxes under the Other Section.
When the name is defined, click to check the checkbox next to the option.

|An example of other additional information is Washing Station.

9. When you have made all of your changes, click the Save button to save the
changes. Then click the OK button to close the Options window.

Selecting Travel Questions for Demob

Follow the steps in this section to define the Air Travel Questions to use in the Demob area of the |-
Suite system:

Also refer to Selecting Demob Options (See Page 65) and Selecting Demob Checkout Options (See Page ‘
66).

IAIR or A/R (Air with Rental) in the Common Data or Tentative Release areas. Travel questions and

Travel Questions only display in Demob if the Travel Method for the selected resource(s) is defined as
answers print on the Commercial Air Travel Request Form.

1. From the Tools drop-down menu, select Options to open the Options window.
2. Click the Demob tab to select it.

3. Click the Travel Questions tab to select it.
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General | Resources | Time | 18P | Cost | Demob | Supply |

Demob | CheckOut || Travel Questions |

[uestion Jizplay || Stand: Move Up |

b |z Ground Support tranzportation needed?

Wl thiz perzon diive themzelves home from jetport’? Move Down |
Doesz this perzon hawve a rental car to retumn’?
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D oes this perzon need hotel reserations?

USRI
==

Yes/Mo Question |
Dizplay [~

(] | LCancel | Clear | Save | Delete |

4. To display a listed question in the Air Travel grid for Demob, click to check the
Display checkbox next to the question.

5. To adjust the order in which a travel question displays, click to select the
Question, and then click the Move Up or Move Down button to adjust the order.

6. Click the Save button to save your changes.

If you uncheck Display for a Travel Question, the responses to the question no longer display. Although
the responses do not display, they are still saved in the database.

Add New Travel Question

Follow the steps in this section to add new travel questions for the Air Travel Request:

[You must click in the grid for the Add button to display. |

1. Click the Add button.
2. In the Question box, enter your new travel question.

3. Click to check the Display checkbox, if appropriate.
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4. Click the Save button to save the new question.

5. When finished, click the Save button to save your changes. Click the OK button to
close the Options window.

Selecting Supply Options
Follow the steps in this section to select options for the Supply area of the I-Suite system:
1. From the Tools drop-down menu, select Options to open the Options window.

2. Click the Supply tab to select it.

w, (ptions

Gereiad | DB Admin | Resouces | Time | 18P | Cost | Demob | Supply | Inkewiiness |
Drafault Incdent

Incident | FROG -

Supply Address

Addresz 1 i
Addess 2 |
City [
Stale —j
£p Code
Phone [I—

lreentory

ok | concel | | save | |

3. From the Incident drop-down list, select the incident to which the supply options
apply.

4. Under Supply Address, enter the supply address, including Address 1, Address
2, City, State, Zip Code and Phone Number.

5. If you want to track the supply inventory, click to check the Track Inventory
checkbox.

6. When you have made all of your changes, click the Save button to save the
changes. Click the OK button to close the Options window.
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Selecting Injury/lliness Options

Follow the steps in this section to select the options to use in the Injury/lliness area of the |-Suite
application:

1. From the Tools drop-down menu, select Options to open the Options window.

2. Click the Injury/lliness tab.

'You can also click the Defaults button on the Injury/lliness window to open the Options window with the
Injury/lliness tab selected.

B[(=1E

General | Resources | Time | 1P | Cost | Demob | Supply | Injurpflliness
FRezource Grid Columns Drop-Diovn D efaulkz

Incident Murnber Move Up _

Incident Mame Incident Type |'wILDLAND FIRE |
v| Request Mumber b v Down
v M ame Management Level ﬂ
| Statusz
| Position Shaw
v| Home Unit Hide
| Confractor

Statz Base

v Agency
(| P arent Position Estimated dverage Houwrs Worked  [15

Checkln Date per Day per Resource

Actual Releaze Date

ok I Cancel | | Save | |

3. Under Resource Grid Columns, hold down the Ctrl key and click to highlight
each of the columns you want to select.

4. If you want to remove the selected columns from the Resource grid, click the
Hide button.

If you want to display the selected columns in the Resource grid, click the Show
button
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Each column with a checkmark in the checkbox next to it is included in the grid. When you click the Show
button, it places a checkmark in the checkbox next to the selected column. When you click the Hide
button, it removes the checkmark from the checkbox. You can also click the checkbox next to a listed
column to either Show or Hide it.

5. To define a default Incident Type to display in the Incident Type box on the
Injury/lliness window, select one of the following options from the Incident Type
drop-down list:

e All Hazard

e Prescribed Fire

e Wildland Fire

e Wildland Fire Use

6. To define a default Management Level to display in the Management Level box
on the Injury/lliness window, select a level (1-5) from the Management Level
drop-down list.

7. To define a default Est. Hrs Worked / Day on the Stats Base window, enter the
amount in the Estimated Average Hours worked per Day per Resource box.

8. Click the Save button to save your changes. Click the OK button to close the
Options window.
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Uninstalling I-Suite

Follow the steps in this section to uninstall the I-Suite application from your computer:
1. Access the folder where you downloaded the I-Suite program.

2. Double click the I-Suite program file (either Client or Server) to open the
InstallShield Wizard.

lguita 2006 Server - InstallShield Wizard

Welcome bo the Isute 2006 Seiver Setup Mainbenance program. This progrsm bels you modiy the
curtenl imstalateon Chek ana of Lhe option: below,

™ Maodiy
Iﬁ Select new progeam features bo add of select cumeritly installiad features Lo remowve.

™ Repas
' ﬂﬁ- Rleinstal al program festues instaled by the previous sehup.

= =
% i+ Remove

@ Remonve all mstalad fostures,

3. Click the Remove option to select it. Then click the Next button.

4. When the message displays asking whether you want to completely remove the
application, click the Yes button.

5. When the uninstall process is complete, a window displays indicating that the
Uninstall is Complete. Click the Finish button to close the window.
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6. Toremove other I-Suite components from your personal computer, do one of the
following:

e To delete all I-Suite components and |-Suite databases, in the Program
Files folder, delete the ISuite folder.

e To delete all I-Suite components, but not the I-Suite databases, access the
Program Files folder. Then open the ISuite folder. Delete the Bin folder.

7. To complete the uninstall process, restart your computer.
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Uninstalling I-Suite Server from
Windows 7 machines

Follow the steps in this section to uninstall the I-Suite application from your computer:

Uninstalling ISuite Server from Windows 7 Machines requires an extra step PRIOR TO
running the ISuite Uninstaller (which is located under the Start Menu under Al
Programs in the ISuite folder). You must first stop the SQL Server 2005 Service named
SQL Server (ISUITE2) as follows:

1. From the desktop, double click the SQL Server Manager icon to start the SQL
Server Configuration Manager.

2. This will open the SQL Server Configuration Manager. Right click on SQL Server
(ISUITEZ2) in the right panel and select Stop.

iy Acton  View Help

|23 7 RRCRORORC

S0L Server Configuration ?.hnﬂwam!

& 0L Server 2005 Services w 5 ISUITED)
_'.J_ SQL Server 2005 Metwork Confaguration (3. —
:'E S0L Matree Client Confgurstion (32bit)

=k 3 !

AR SOL Server Browser ta
Stop
Pause

Restart

Propeerties

Help

3. SQL Server (ISUITEZ2) is now stopped.
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File Action View Help

e 7|0 = B

ﬁ SQI. SEpeEr {:nnﬁgur.:l:inn Mg nages (Local) [l Mame Gia
E SOL Server 2005 Services iy SQL Server (ISUTTE2) @
SO Server 2005 Network Cenfiguration 3| = 3 PR

. ¥ 50L Server Browser
B 501 Mative Client Configurstion (32bit) s

4. Do not stop the SQL Server Browser service.
5. Close the window by clicking on the red X in the upper right corner.

6. Proceed to uninstall ISuite using the ISuite Uninstaller provided with the ISuite
application.
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Appendix A

Revision History

Revision Revision Summary

Date

2010-08-20 Revised instructions for SQL Server Exception Procedures.

2010-04-27 Revised instructions for the 10.01.00 version of I-Suite.

2009-05-01 Revised instructions for the 9.01.00 version of I-Suite.

2008-09-04 Revised instructions for the 8.01.04 version of I-Suite.

2008-04-25 Revised instructions for the 8.01.00 version of I-Suite.

2007-07-25 Revised instructions for the 7.01.05 version of I-Suite.

2007-04-20 Revised instructions for the 7.01.00 version of |-Suite.

2007-01-09 Revised instructions based on changes received for Training Manuals.

2006-12-04 Revised instructions by adding more detail and graphics.

2006-06-26 Added instructions for installing the I-Suite Client version. Added instructions for adding a
SQL Server instance and the I-Suite program to the Windows Firewall Exceptions list.

2006-05-01 Revised instructions for initial install and setup of I-Suite.

2006-04-17 Instructions for Getting Started with the new |-Suite 2006 application.
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